
 
 

 
Pharmaserv 

 
 

Getting Started Guide 
 

For use with the 
Pharmacy Management System 

from McKesson 
 
 
 
 
 
 

 
 

 
1110913 
PRODUCED IN CORK, IRELAND 



©Copyright 2014.    Pharmaserv® Getting Started Guide.                                                                                                         2 

Copyright 
© 2014 McKesson Corporation and/or one of its subsidiaries.  All Rights Reserved.  This 
documentation is a publication of McKesson Corporation and/or one of its subsidiaries, which 
may be used only in accordance with a license agreement with McKesson Corporation and/or 
one of its subsidiaries.  Any unauthorized use, duplication, or disclosure is prohibited. 

The content of this documentation is furnished for informational use only, is subject to change 
without notice, and should not be construed as a commitment by McKesson Corporation 
and/or one of its subsidiaries. McKesson Corporation and/or one of its subsidiaries assumes 
no responsibility or liability for any errors or inaccuracies that may appear in this 
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Welcome 
 
McKesson Pharmacy Systems (MPS) welcomes you to the growing number of pharmacists who have 
selected the Pharmaserv® pharmacy management computer system for their pharmacy business. 
 
In today's retail pharmacy environment, where cost containment is critical and the competition is fierce, 
MPS is committed to providing the products, services, and third party support to help keep you 
profitable. 
 
This guide provides you with vital information to help ensure the successful implementation of your 
Pharmaserv system.  
 
The Pharmaserv Getting Started Guide is organized as follows: 
 
 Welcome provides an overview of the features in the Rx Processing and the 

Pharmaserv applications and other services offered by McKesson Pharmacy Systems 
such as customer support and label supplies.  

 
 Introduction to Microsoft Windows describes the key elements of the Microsoft® 

Windows® desktop and provides some basics for how to “move around” in windows and 
how to select options. 

 
Starting The Pharmaserv System outlines the server and client relationship and provides 
step-by-step instructions for accessing your system using the Windows Server 2008 operating 
system. 

 
 Using Rx Processing covers basic operations within the Rx Processing application. 

(The Pharmaserv application provides access to optional Long-term Care and Accounts 
Receivable modules.) 

 
 Using Online Help explains how to access and use the online Help for up-to-date 

information while you are using the Rx Processing and Pharmaserv applications.  
 
 Customizing Your System provides an overview and checklist of the steps your system 

administrator must complete to customize your Pharmaserv system. 
 
 Establishing Initial Information provides general procedures and checklists for 

establishing initial information such as pricing schedules, prescribers, and patients. 
 

Appendix A: Base Data identifies the information provided by McKesson Pharmacy Systems 
when you receive your Pharmaserv system.  (NOTE: Customers converting from a previous 
Pharmaserv system or competitor’s system may have additional base data as a result of their 
conversion.) 
 
Appendix B: System Administrator Requirements provides guidelines for managing your 
Pharmaserv system and its users. 
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Overview of Features 
 
Designed with the pharmacist in mind, Pharmaserv gives you complete control over every aspect of 
your pharmacy and helps you keep pace with today's rapidly changing health-care industry.  Whether 
it's filling a new prescription, pricing an Rx, or generating a management report, the Rx Processing 
application provides you with a wide range of practical and innovative features. The Pharmaserv 
application provides access to Dashboard, Rx Tracker, and other optional modules. 
 
Following is a brief overview of some of the features in the Rx Processing application: 
 
 • Complete prescription filling process.  You can quickly fill a prescription for a customer and 

automatically check the prescription information for third party billing requirements, calculate 
prices, copays, days supply, and provide patient warnings based on patient allergies and 
medical conditions and drug interactions. The system supports electronic transmission of claims 
to third party carriers immediately after filling a prescription, with Rx correction and rebilling 
options.  DUR response information can be transmitted.  Optional e-Prescribing capabilities 
enable you to electronically submit refill requests, receive refill authorizations and new Rxs 
using Surescripts. 

 
 • Pricing flexibility.  Pricing formulas provide complete control over pricing strategies.  You have 

the ability to apply premium add-ons to improve profits.  MPS provides daily and weekly price 
updates. The optional Auto-Rx-Net service automatically updates Pharmaserv price schedules 
based on competitive prices in your area. Call your MPS representative for details. 

 
 • Total third party control.  When filling prescriptions you can enter and edit all data required by 

the third party carrier as well as plan and group variables.  This enables you to reduce carrier 
rejects and efficiently handle third party processing. 

 
 • Detailed patient profile information.  The Rx Processing application enables you to enter 

detailed information about your patients, including insurance information, vital statistics, patient 
counseling information, allergies, and medical conditions.  

 
 • Extensive reporting capabilities.  The Report Manager module enables you to schedule and 

print a variety of reports for Pharmaserv and other licensed products.  
 
 • Business maintenance.  Establish and maintain mailing address, contact name, telephone 

number, and other information about the transfer pharmacies and various companies with which 
you do business. 

 
 • Extensive prescriber profiles.  You can enter and maintain information on any person 

prescribing medication, including doctors, physician assistants, and dentists.  This information 
includes licensing and carrier participation. 

 
• Online Help.  The online Help provides procedures, window explanations, and field definitions.  

Access the online Help at any time within the Rx Processing or Pharmaserv applications. 
 
To help you use these features, the system incorporates user-friendly tool bar buttons to represent 
common functions.  These buttons are located across the top and below the menu bar of each main 
window on what is called the horizontal tool bar.  Selecting these buttons opens a different module. 
 
Within each module, additional buttons are available on the left side of the window, commonly referred 
to as the vertical tool bar.  Selecting a vertical tool bar button opens a window related to the current 
module. 
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McKesson Pharmacy Systems Software Support Guidelines 
 
McKesson Pharmacy Systems provides software maintenance support which includes enhancements 
and new releases.  Maintenance support is also provided for all peripherals listed in your Purchase 
Agreement.  You can contact the Customer Support Department at:  
 

1.800.424.0444  Option #1 or listen to the menu for other options 
 

Monday through Friday 8:30 a.m. to 11 p.m. Eastern 
Saturday 8:30 a.m. to 5 p.m. Eastern 

Saturday on-call coverage 5 p.m. to 9 p.m. Eastern 
Sunday on-call coverage 9 a.m. to 9 p.m. Eastern 

 
McKesson Pharmacy Systems also offers a Customer Support Web site at 
www.mckessonpharmacysystems.com  
 
McKesson Data Backup Service is an automated, cloud-based service that continuously runs every 15 
minutes to backup critical data elements (for example, your database) necessary to recover 
Pharmaserv information in the event of catastrophic failure.  This data is stored offsite in secure, 
underground, mirrored data vaults.  Data is completely secure and protected at every step of the way 
using stringent procedures, protocols, and standards. 
 
You will receive a nightly e-mail from MPS (that can be viewed through Microsoft Outlook) displaying 
basic statistical information regarding the prior day’s backup.  Contact Pharmaserv Product Support for 
assistance if you are not receiving these e-mail messages or are having trouble viewing them.  A 
notification is sent to MPS whenever a backup fails.  The MPS System Support department will contact 
you to troubleshoot and resolve the issue.  See the section Using Microsoft Outlook Mail in this guide 
for more information. 
 
McKesson Pharmacy Systems assumes no responsibility for re-creating data destroyed by hardware 
malfunctions, operator misuse, or abuse.  If you request additional software support services, such as 
file re-creation or other services not covered, MPS provides the services within its reasonable 
capabilities and at the existing service rate. 
 
If you lose or corrupt the data on your system, MPS restores your Pharmaserv system software and 
data, and the operating system.  MPS is not responsible for restoring other software or data on your 
system. 
 
In addition, when MPS is performing maintenance to your system, no one should attempt to access the 
system unless specifically instructed to do so by MPS personnel. To begin using the system prior to 
MPS completing its work and/or without our knowledge can cause loss of data and programs.   MPS is 
not responsible for loss under any of the above conditions. 
 

http://www.mckessonpharmacysystems.com/
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McKesson Printing Services 
 
MPS offers the convenience of ordering prescription labels and forms directly through McKesson 
Printing Services, a division of MPS.  Since 1981, Printing Services has been committed to providing 
high quality products and services at competitive prices to pharmacies nationwide. 
 
McKesson Printing Services is a full service printing division.  The in-house graphics department is 
available to assist you in designing labels and forms that incorporate your logo and unique business 
personality.  The labels and forms are printed at our Livonia, Michigan facility.   
 
To view label samples visit the McKesson Pharmacy Systems web site at 
www.mckessonpharmacysystems.com  
 
McKesson Printing Services has knowledgeable and courteous customer service representatives who 
are available to answer questions about their complete product line. Business hours are 8:30 a.m. to 5 
p.m. Eastern, Monday through Friday, with voice mail available at any time. To talk to a representative, 
call 1.800.521.1758 extension 8550.   
 

Introduction To Microsoft Windows 
 
Pharmaserv uses the Microsoft Windows Server 2008 operating system on the server and Windows XP 
or Windows 7 on client systems.  This section provides you with an overview of the Windows 
environment.  
 
This section covers the following information: 
 

• The Desktop   
 

• Using the Start Menu 
 

• Using the keyboard and mouse 
 

• Manipulating windows including opening, sizing, moving, and closing windows 
 

• Using the menu bar commands 
 

• Selecting options within a window 
 
 
 
 

http://www.mckessonpharmacysystems.com/
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The Desktop 
 

 
  
The Desktop displays all of the shortcut icons you have on your system.  The Start button at the bottom 
left enables you to access all of the programs and applications on your system from the Start menu. 
 
Rx Processing Icon 
 

 
 
 
Pharmaserv Icon 
 

 
 
 

NOTE: Sample windows included in this document may display options available only when       
 optional Long-term Care or Accounts Receivable modules have been activated. 

Double-click the Rx Processing icon to access the Rx Processing 
application. This is where you spend most of your time on the system, 
utilizing business, patient, prescriber, third party information, etc. 
 

Double-click the Pharmaserv icon to access Dashboard, Rx Tracker, 
and other optional modules. 
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Using the Start Menu 
 
The System Administrator (see Appendix B) accesses the Rx Processing and Pharmaserv applications 
by double-clicking the appropriate icon from the Desktop on the server.  Other users can access the 
applications from a client system. To access other programs on your system, click the Start button.  
When you click on the Start button, the Start menu displays similar to the following:  
 

 
 
 
Click All Programs to access a complete list of programs available on your system. 
 
To shrink an application window into a taskbar button at the bottom right of the window, use the 
minimize button (minus sign) in the upper right corner of the window as shown below. 
 

 
 
By minimizing the window, you can clear space on the Desktop without exiting active applications. 
 
When you access the application from a client system, you are using functionality called terminal 
services.  This is covered later in the Starting The Client Systems section. 
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Using the Keyboard and Mouse 
 
Use the keyboard or a mouse to move around the Desktop.  General directions about the mouse and 
keyboard are provided below. 
 
 
Using the Keyboard 
 
When using the keyboard, selections are made by pressing one key or a combination of keys.  When 
two or more applications are open, you can hold down Alt and then press Tab to change to other 
applications without closing the open window. 
 
 
Using the Mouse 
 
When using the mouse, selections are made based on how you move and click the mouse.  Make 
selections with the mouse using the following techniques.  Click is used throughout the guide and it 
always refers to using the left button on the mouse. 
 

• Click means move the mouse pointer to a selection and press and release the left mouse 
button.  This technique selects an object or performs an action. 

 
• Double-click means move the mouse pointer to a selection and then press the left mouse 

button two times in rapid succession.  This technique selects and opens the selection. For 
example: double-click the icon on the Desktop to open the Pharmaserv application. 

 
• Click and drag means move the mouse pointer to a selection, click on the selection and then 

continue to hold down the left mouse button while you move the mouse from one place to 
another across the window. 

 
• Right-click means press and release the right mouse button. This technique displays a menu to 

enable other commands. 
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Manipulating Windows in Pharmaserv 
 
Windows can be opened, closed, selected, moved, and sized.  To start an application from an icon, 
double-click on the application icon. 
 
 
Scrolling Through Windows 
 
When a window cannot display its entire contents, horizontal and/or vertical scroll bars display.  Below 
is a sample window that is sized too small to display its entire contents:     
        

 
 
In the above example, the horizontal scroll bar displays indicating that there is more information on the 
window.  The scroll bar indicates the position of the window display relative to the entire view of the 
window. 
 
To move the window left and right, click on the left or right arrow icon in the horizontal scroll bar.  You 
can also click and drag the scroll box to the left or right until a specific view displays.  You can perform 
the same functions with the vertical scroll bar by moving up or down. 
 
 
Changing Window Sizes 
 
You can control the size of most windows by using buttons which are located in the upper right corner 
of the window:   
 

 
 
The buttons are known as Minimize (-), Maximize (square), Restore (overlapping squares), and Close 
(x). This enables you to easily view other applications that are running without exiting the current 
application. When you move the cursor over a button the name “pops-up.” 
 

Vertical  
Scroll Bar 

Horizontal 
Scroll Bar 
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Minimize Button 
 

   To minimize a window, click on the minimize button (minus sign).  The minimize button turns the 
window into a taskbar button at the bottom of the Desktop.  The taskbar button displays the icon and 
the name of the application.  Even though the application appears to be closed, it is still running in the 
background.  To restore a minimized window, click that button representing the application on the task 
bar. 
 
Maximize Button 
 

   To maximize a window, click on the maximize button (square).  The maximize button enlarges the 
window to its full size.  When a window is maximized, all other running applications are in the 
background.  
 
Restore Button 
 

   When a window is “maximized” the restore button (overlapping squares) replaces the maximize 
button. Click the restore button to “restore” the window to its original size. 
 
Close Button 
 

   After you have saved your work in a window, close the window by clicking the close button (x).  
(NOTE: When you are closing a Remote Desktop Connection, use the Log Off button in the Start 
menu instead of the close button). You can also click File on the menu bar and then click Exit to close 
the window. 
 
 

Changing the Height and Width of a Window 
 
In addition to minimizing and maximizing windows, you can make windows larger or smaller if the 
window is NOT maximized.  To change the height of a window, use the mouse to click and drag the top 
or bottom border.  The mouse pointer changes to a double sided arrow (↔).  To change the width of 
the window, click and drag the left or right border.  To change the height and width at the same time, 
click and drag one of the corners. 

 
 

Moving Windows and Icons 
 
You can move windows and icons to different places on your Desktop.  To move a window: 

 
 1. Click in the title bar of the window and drag the mouse to move the window where you want it.  

The title bar is part of the top border of the window. As you move the mouse pointer, an outline 
of the window moves with it.  For an icon, the mouse pointer changes to a black and white 
outline of the icon that moves as you move the mouse. 

 
      2. To cancel the move, press Esc before releasing the mouse button.  When the window or icon is 

positioned where you want it, release the mouse button.   
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Using the Menu Bar 
 
The menu bar is located below the window’s title bar and provides access to several menu options.  
The following is the menu bar for the Rx Processing application:  
 

 
      
To display a menu, move the mouse pointer over the menu name and click with the left mouse button.  
A list of commands display.  Dimmed options are unavailable.  Below is a sample Rx menu:  
                                   

 
 
To select a menu option, click on the name.  
 
 
NOTE: The optional Accounts Receivable or Long-term Care modules can be accessed from the 
Pharmaserv application menu bar similar to the following: 
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Selecting Elements on a Window 
 
Following is a description of the various elements—command button, field, radio button, check box, 
drop-down list box—on a window.  A sample window illustrates the various elements:  
 

 
 
 
Command Button 
 
A command button is a button that begins an action.  Clicking a command button immediately starts the 
action.  To select a command button, move the mouse pointer to the button and click the left mouse 
button.  You can also press and hold the Alt key and click the underlined letter on the button; like S on 
the Save button. 
 
 
Field 
 
A field is usually a box in which you can enter information.  If the field is dimmed you cannot access the 
field.  To select a field to enter information, move the mouse pointer to the box and click the left mouse 
button.  If the box is empty, enter the new text.  If the box has existing text, it is automatically 
highlighted.  To replace existing text, type over it. 
 
 
Check Box 
 
A check box enables you to toggle (select or clear) the option.  To select/clear the check box, move the 
mouse pointer to the square and click the left mouse button.  
 
 
Radio Button 
 
A radio button is a circle that enables you to select or clear an option.  You can select only one radio 
button in a group.  If you select a second option, the first radio button is cleared.  To select the radio 
button, move the mouse pointer to the circle and click the left mouse button.   

Drop-down 
List Box 

Command 
Button 

 Radio Button 

Check Box 

Field 
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Drop-down List Box 
 
A drop-down list box is a box with a down arrow, usually on the right.  Clicking on the down arrow 
displays a list from which you may choose. 
 
There are two types of drop-down list boxes.  A list box that has a space between the field and the 
down arrow can be edited.  You can enter information in the field or make a selection from the drop-
down list.   List boxes that cannot be edited do not have a space before the down arrow. 
 
To select a drop-down list box, click on the arrow to display the drop-down list of options.  Then click on 
the selection.  
 
 
NOTE:  You can use the Tab key to move from field to field on any window.  When the field or option is 
highlighted, it is active for entry or changing. 
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Starting The System 
 
The Pharmaserv system consists of a “server” system and one or more “client” systems. 
 
This section provides the following information: 
 

• Before you start the day 
 

• Understanding the client/server relationship 
 

• Procedures for starting your server system 
 

• Procedures for starting your client systems 
 

• Using Microsoft Outlook Mail 
 

• Using the Rx Processing application 
 
 

Before You Start The Day 
 
You should perform the following steps each morning before accessing the system: 
 

1. Verify end-of-day reports for accuracy. 
 

2. Check your mail for the following: 
 

a.) Success of backup 
 
b.) Messages received from the system 
 
c.) Messages received from McKesson 

 
See the Using Microsoft Outlook Mail section for more information. 
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Understanding The Client/Server Relationship 
 
The Rx Processing application is installed on the server system. The server system holds and 
manages data that can be accessed by clients.  The client systems are connected to the server via a 
network. The client systems allow multiple users to access and enter data that the server processes.  
Pharmacists and technicians can access the application from anywhere in your pharmacy where a 
client is available.  
 
You can establish basic System Preferences in Pharmaserv Administration at the server as to how data 
should be handled and how applications run.  These preferences determine what client systems can 
access and how data is processed.  
 

Starting the Server 
 
The server is the main system. Before you access the server for the first time using the Windows 
Server 2008 operating system, YOU MUST CONNECT AND POWER ON THE MODEM (if your 
system is equipped with a modem). 
 
The person in your facility assigned as the System Administrator must start the server before any client 
system can access the Rx Processing application.  THE SERVER MUST BE LEFT ON AT ALL TIMES. 
When the server is first accessed, the Windows startup sequence begins.  The Begin Logon window 
displays.  Hold down the Ctrl – Alt – Del keys in sequence to access the Logon Information window. 
 
You must logon to the computer by entering the Username and Password assigned to the server.  Valid 
users are set up by the System Administrator.  Once you have entered the valid login information, click 
OK to continue. The Pharmaserv logon window displays. 
 
Most facilities use multiple clients to access and run the Rx Processing application on a daily basis. 
 

Starting the Client Systems 
 
Once the server is started you can turn on client systems and access Pharmaserv.  The Remote 
Desktop component of Microsoft Windows Server 2008 enables you to use the Remote Desktop 
Connection on your client system to access the Rx Processing application on your server system. 
 
When you turn on a client system, the Windows startup sequence begins.  The Begin Logon window 
displays.  Press the Ctrl – Alt – Del keys to access the Logon Information window.  You must logon 
using the Username and Password assigned to you.  Once you have entered the valid login 
information, click OK to continue.  The Windows Desktop opens. 
 
NOTE:  The Pharmadmin user should be used only for initial setup.  The Store Manager user can be 
used for daily Pharmaserv functions. 
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1. Click the Pharmaserv Remote Desktop icon (shown below).  
 

      
 

2. Enter your server name and click Connect.  (NOTE: If your server name does not display, 
please contact your MPS Implementation Project Manager.) A similar window opens and 
prompts to enter your Username and Password. 

 
3. Enter your Username and Password. Click OK.  You now have remote access to the server and 

you can use the system just like you were standing at the server.  The server name displays at 
the top of your client screen.  The Pharmaserv login window displays.  You can either log into 
the application or cancel to return to the desktop. 

 
4. To exit or close the Pharmaserv Remote Desktop Connection (a terminal services session), be 

certain to exit from all of the applications.  After a short processing delay, the session will close 
by itself. 

 
 

IMPORTANT: Do not use the close button (x) as this will not close the Pharmaserv 
session.  Using this button to exit could result in hardware connection 
problems the next time you log into any system. 
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Using Microsoft Outlook Mail 
Use Outlook Mail to review daily messages regarding the status of your system backup and database 
maintenance. You can also check for Price updates, MAC price updates, GPI updates, Medi-Span® 
updates, and iDigicall messages from McKesson Pharmacy Systems.  If you are a new user, or you are 
logging into the system for the first time, you must follow the instructions below. 
 
NOTE:  It is recommended that you designate a single user as the person to access mail daily.  Only 
the user logged in when messages are received becomes the sole owner of these messages and the 
messages cannot be viewed by other users. 

 
1. Double-click the Microsoft Outlook icon from the Desktop. Skip to Step 5 unless the Internet E-mail 

- store window displays similar to the following: 
 

 
 
NOTE:  This window may display the first time for each user. 

 
2. Type store in the Password field. 
 
3. Select the Save this password in your password list check box. 
 
4. Click OK. 
 
5. The Inbox-Microsoft Outlook window opens and retrieves all pending messages. 
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Log On To The Pharmaserv Application 
 
Before you log on to the Pharmaserv application, all system preferences and users should be assigned 
by the System Administrator.  See the appropriate section if this information applies to you. 
You can run the Pharmaserv application from the server or any client system.  Most people access the 
application from the client system using Terminal Services functionality.   
 
When accessing the server, the Pharmaserv application automatically opens to the Pharmaserv Logon 
window, similar to the following: 

 
 

 
 
Enter information in the fields listed below: 
 
Field Enter 
 
User ID User ID assigned to you by the System Administrator. 
 
Password Password assigned to your User ID for security. 
 
From the Logon window, you have the following options: 
 
Click To Do This  
 
OK Indicate the Logon ID and password are correct and access the Rx 

Processing application. 
 
Cancel Exit without accessing the Rx Processing application. 
 
Help View online Help for instructions. 
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Once you log on to Pharmaserv, move the mouse pointer to the Rx Processing icon on the toolbar and 
click the icon: 
 

 
 
After you log on to the application and the Medi-Span module is successfully initialized, a window 
displays similar to the following:  
 

 
            
Click OK to continue.   
 
NOTE:  If the Medi-Span database has expired, the DUR screening does not occur. 
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The Rx Processing application opens similar to the following: 
 

 
 
 
You are now ready to use the Rx Processing application! 

 

Single SignOn 
 

 
 
Single SignOn enables you to log in or authenticate one time to access multiple applications.  The 
authentication process eliminates the need to log in each time you switch applications during a session.  
You can choose to always display the Single Sign On window on top of the active window or to send it 
to the back and not remain on top of the active window. 
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Using The Rx Processing Application 
 
Rx Processing uses some conventions to help you easily move through the application and perform 
necessary functions.  This section defines the following conventions for you: 
 
 • Closing a window 
 
 • Horizontal toolbar buttons and keyboard shortcuts 
 

• Vertical toolbar buttons and keyboard shortcuts 
 
 • Field information such as use of colors and multiple entries 
 
 • Information lookup processes 
 
 • Main windows and secondary windows 
 
 • Exiting Rx Processing 
 

Closing a Window 
 
To close a window in Rx Processing, click on the close box in the upper right corner of the window.  Be 
careful not to select the close box on the main (outer) window because the application closes.  The 
close boxes are shown from a sample window below: 
 

    
 
If information has been entered and not saved, you are prompted to save the information before closing 
the window.  Windows without a close box can be closed by selecting one of the following command 
buttons: 
 
 • OK 
 
 • Save 
 
 • Cancel 
 
When you are finished working in a window, you should always close the window.  This ensures that 
your information has been saved and frees system memory for faster processing.  Your system runs 
much more efficiently if you keep the number of open windows to a minimum. 
 
 

Closes the application 
 
 
 
Closes Rx Processing window 
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Tool Bar Buttons 
 
Rx Processing uses two tool bars.  The horizontal tool bar (left to right at the top of the window) has 
buttons you select to begin a specific module within the Rx Processing application.  The vertical tool bar 
(up and down the left side) buttons enable you to perform a specific function within the module.  A 
sample window shows the tool bar buttons: 
 

 
                             

Horizontal Tool Bar Buttons 
 
The horizontal tool bar buttons display in a row at the top of each window in Rx Processing: 
 

 
 
Following is an explanation of the horizontal tool bar buttons. 
 

Tool Bar Button  Explanation 
Business (Building icon) 
 

    Shortcut:  Ctrl + B 

Opens the Select Business window enabling you 
to access the functions in the Business module.  
Enter information about your pharmacy and the 
companies (e.g., employers, manufacturers, 
suppliers, other pharmacies) with which you do 
business. 

Carrier (Coverage Card icon) 
 

    Shortcut:  Ctrl + A 

Opens the Select Carrier window enabling you to 
select and enter information about the carriers 
that you bill. 
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Tool Bar Button  Explanation 
Item (Capsules icon) 
 

    Shortcut:  Ctrl + I 
 

Opens the Select Item window enabling you to 
access the functions available in the Item 
module.  Establish information about the items 
you dispense, including clinical information, and 
pricing. 

Patient (Person and Vial icon) 
 

    Shortcut:  Ctrl + R 

Opens the Select Patient/Rx window enabling 
you to access the functions available in the 
Patient and Rx modules. Fill and refill Rxs and 
enter information about your patients and Rxs. 

Prescriber  (Medical symbol icon) 
 

    Shortcut:  Ctrl + E 

Opens the Select Prescriber window enabling 
you to access the functions in the Prescriber 
module. Establish information about the 
individuals who prescribe Rxs for your patients. 

Price Check 
(Dollar Sign/ Check Mark icon) 
 

    Shortcut:  Ctrl + K 

Opens the Price Check window enabling you to 
check prices on items on your screen before you 
fill the prescription. 
 

CAM Status (Traffic Light icon) 
 

    Shortcut:  Ctrl + T 

Opens the CAM Status window enabling you to 
review the results (approved, rejected, etc.) of 
claims that have been sent to a third party carrier 
for adjudication. 
 

Pharmaserv 
(Letter P and Globe icon) 
 

  Shortcut:  Not Available 

Opens the Pharmaserv application and provides 
access to additional options. 
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Vertical Tool Bar Buttons 
 
The vertical tool bar buttons vary depending upon your location within the application.  Buttons that are 
not available have the universal No symbol displayed over the button (sample below) to indicate that 
you cannot select this button. 
 

 
 

The vertical tool bar buttons relate to the specific window from which the button is selected.  
 
 
Standard Vertical Tool Bar Buttons 
 
The Notes and Maintenance vertical tool bar buttons are standard throughout the application.  They 
display on most windows and perform a consistent function.  The buttons can be accessed by keyboard 
shortcuts by pressing and holding the Alt key + the corresponding underlined letter. For example, the 
Notes button has the N in Notes underlined (below) so you can hold Alt and press N (Alt + N) to open a 
Notes window. 
 

 
 
When the Notes tool bar button is selected, you can enter notes specific to the window that you are 
using. The Maintenance vertical tool bar button (sample below) is available when the field that has 
focus has an associated Maintenance window. 
 

 
 
The Maintenance vertical tool bar button (Alt + M) brings up the appropriate Maintenance window.  For 
example, if any of the address fields have focus and this button is selected, the Address Maintenance 
window opens.  
 
Codes can be quickly accessed via the Maint tool bar button for those codes that can be modified.  For 
example, if you place the focus on the Instr or Single Line Edit (no label) field for an Rx, and then click 
Maint, the Signa Code Maintenance window opens enabling you to enter a new Signa Code.  (Ask your 
trainer about other Code Maintenance shortcuts using Ctrl + D.) 
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Field Information 
Colors 
 
The Rx Processing application uses specific colors to help you easily identify field types: 
 
Teal background/bold field label  Field is required. You must enter 

information in this field before the 
information in the window can be 
saved. 
 

Gray background  Field is display-only and cannot be 
edited.  
 

White background  An entry field that is not required 
(optional). 

Pale Yellow  Display-only field which cannot be 
edited directly, but has maintenance 
functions available for editing, or can 
be edited in another window. 
 
For example, patient date of birth is 
pale yellow on the New Rx window, but 
can be edited on the Patient 
Maintenance window. 

 
 
Fields with Multiple Entries 
 
Fields such as address and telephone numbers support multiple entries.  Pharmaserv identifies the 
fields that can have multiple entries with a chevron (>).  These fields can be maintained from 
Maintenance windows, available by selecting the Maintenance vertical tool bar button when the field 
has focus.  

Some of the optional modules use an ellipsis button     to indicate that more information is needed. 
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Information Lookup 
 
At times you will need to look up information within the application (e.g., prescriber name, item, carrier, 
etc.) and in most cases, you can perform a lookup by entering selection criteria on a selection window.  
When entering the selection criteria, enter as much or as little of the criteria as you may know.  
Pharmaserv displays all matches that use the criteria in a results area.   
 

 
 
For example, if you are searching for a patient with a very long name or an item with multiple strengths, 
you could enter just the first few letters of the name and click Retrieve.  Then make a selection from 
the results window. The sample above uses TYLENOL as the criteria. The results window shows the 
various TYLENOLs that match your search. 
 
You can scroll through the list in the results area either by clicking on the up or down arrows in the 
vertical scroll bar, by dragging the scroll box up and down, or by using the up and down arrows on the 
keyboard.  To move the window left and right, click on the left or right arrow in the horizontal scroll bar.   
 
In other instances, such as prescription processing, a search is performed automatically once you 
press Tab to exit the selection field.  This is used in places where only one selection criteria field is 
available. 
 

The results 
area displays 
the matches to 
the search 
criteria. 
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Header or Main Window 
 
Each module is composed of one main window and several secondary windows which display and/or 
accept information.  The header window is the main portion of the window displayed on the top of most 
secondary windows as seen with the Item Maintenance window below: 
 

 
 
 

Secondary Window 
 
The secondary window (Item Summary above) displays within a main window and usually displays as a 
result of a selection made (from a tool bar or command button).  
 

Exiting Rx Processing 
 
When you are done using Rx Processing and want to exit the application, click the close box in the 
upper right corner of the main window.  A confirmation box displays.  Click Yes to exit. 
 

IMPORTANT: To exit or close a Remote Desktop Connection (a terminal services 
session), be certain to use the Log Off button. 

    
Do not use the close button (x). 
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Using Online Help 
 
Online Help is a convenient way to lookup information without leaving the application.  The Rx 
Processing and Pharmaserv applications provide context-sensitive Help, which means that you can 
read Help specific to the field which has focus.  Or, you can use the Contents, Index, Search, and 
Favorites (Pharmaserv only) options to view helpful information. 
 
This section explains the following information: 
 
 • Accessing Help and using Index, Contents, Search, and Favorites options 
 
 • Using Field level Help 
  
 • Identifying other Help menu options 
 

Accessing Help 
 
There are several methods to access Help.  You can open the Help menu and search for Help by using 
an Index, Contents, or Search option, and you can use Field level Help from within the application. 
To display an index of Help topics, click Help from the menu bar and then click Help Topics.   The 
following windows vary slightly when accessed in the Pharmaserv application. 
 

 
 
The Rx Processing Help window opens similar to the following: 
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Online Help offers a quick way to find information just like thumbing through an index. Highlight the 
topic and click Display. A window displays with the information you need.  The following topics are 
available by selecting the Contents tab on the Rx Processing Help window: 
 

 
 

Rx Processing Overview provides general information about the application such as the horizontal 
and vertical tool bar buttons, keyboard shortcuts, etc. 
 
System Start-up provides a list of the steps that should be followed before you begin using the 
application.   
 
Windows Available in Rx Processing describes the windows available in each module with field 
definitions and command button explanations.  This is similar to a Reference Manual, describing 
each window within the software. 
 
How To... provides the procedural information you need to perform functions in Rx Processing.  
This is similar to a User Manual. 
 
Reference Materials provides a glossary of terms used in the online Help. 

 
You can select a topic from Contents by double-clicking on a book icon in Contents. Under some of 
Contents entries, another book icon may display.  These are usually divided by categories.  Continue 
selecting topics until the information displays. 
 
The online Help in the Pharmaserv application adds a Favorites tab. The Contents tab opens to the 
Introduction to Pharmaserv Help and displays the following options: 
 

Online Help and User Interface Features contains introductory information that helps you 
understand the online Help in the Pharmaserv application. 
 
Menu Bar describes the commands and functions available from the menu bar. 
 
Accounts Receivable provides an overview to the optional Accounts Receivable module. 
 
Long-term Care provides an overview of the optional Long-term Care module. 
 
Pharmacy Navigator provides an overview to the optional workflow management module. 
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Point-of-Sale provides information on eight features available in the optional Point-of-Sale module. 
 
Point-of-Sale Register provides information on the main window of Point-of-Sale register window. 
 
Report Manager provides an overview to the Report Manager module which enables you to view, 
print, and schedule reports. 
 
Signature Center provides an overview to the optional electronic signature capture device. 
 
Supply Management provides an overview to the Supply Management module. 
 
Glossary provides access to an alphabetical list of terms used in the Pharmaserv application. 

 
When you click the Search tab, a window opens similar to the following: 
 

  

Type what you want to find and matching 
words display. Click a matching word or 
click a topic, and click Display. The system 
searches and displays the word highlighted 
in a matching topic. 
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Using Field-Level Help 
 
On an Rx Processing window, you can access Help at any time by pressing Shift and F1 to display an 
explanation of a field or area where the cursor is located.  
 
On a Pharmaserv window, you can access Help at any time by pressing F1 to display an explanation of 
a field or area where the cursor is located. 
 
To access Help for a specific field on an Rx Processing window, press Shift and F1 when the field has 
focus.  Field-level Help overlays the window similar to the following:  
 

 
           
Other options available on the Help menu include: 
 
Rx Processing Application Description 
Help Topics Opens Help on the Index tab. 
Product Support  For future use. 
About Rx Processing  Displays Version and License information. 
 
Pharmaserv Application Description 
Help Topics Opens Help on the Contents tab. 
About Pharmaserv Displays Version and License information. 
Medispan Imprint/Image 
Information 

Displays Medi-Span database and License information. 
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Jumps and Pop-up Windows in Help 
 
Help topics can include text or graphics that link to other Help topics or to more information about the 
current topic.  These are called jumps and pop-ups and they are identified by underlined blue text.  
Jumps take you to a related topic while pop-up windows define the underlined term and display over 
the topic, so you do not have to exit the current topic to obtain this information.    
 
 
Selecting a Jump 
 
To select a jump in Help, click on the blue text or press Tab until the text is selected, then press Enter. 
When the underlined text is selected, a new topic displays. 
 
 
Selecting a Pop-Up Window 
 
When a pop-up window is selected, a window “pops up” with additional information about the selected 
text. To close a pop-up window, click in the pop-up window or anywhere else in the Help window. 
 
 
Help Command Buttons in Rx Processing 
 
Command buttons in the Rx Processing application display at the top of a Help topic window to make 
finding information easier as shown below: 
 

 
 
Tab/Option Description 
Contents Provides access to the table of contents for online Help. The 

book icons represent chapters.  
Index Displays an index of key words in online Help. 
Search Enables you to locate Help topics by entering a word or phrase. 
Hide/Show Enables you to toggle and either hide or show the left frame. 
Back Enables you to view the topic before the current topic. 
Print Enables you to print the selected topic or the selected heading 

and all subtopics. 
Options Enables you to access various options in Help including Back, 

Forward, and Print.  
 
To exit Help, click Exit or click the close box. 
 
Help Options in Pharmaserv 
 
A Help topic window in the Pharmaserv application displays similar to the following: 
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Tab/Option Description 
Contents Provides access to the table of contents for online Help. The 

book icons represent chapters.  
Index Displays an index of key words in online Help. 
Search Enables you to locate Help topics by entering a word or phrase. 
Favorites Enables you to save topics you view frequently. 
Hide/Show Enables you to toggle and either hide or show the left frame. 
Back Enables you to view the topic before the current topic. 
Forward Enables you to view the topic after the current topic. 
Print Enables you to print the selected topic or the selected heading 

and all subtopics. 
Previous Enables you to display the previous topic in a browse sequence. 
Next Enables you to displays the next topic in a browse sequence. 

 
Browse Sequence is the unlabeled area above the right frame and it displays a series of topics in a 
specific order. You can select a browse sequence from the drop-down list below the Previous and Next 
options. 
 
To exit Help, click the close box. 
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Customizing Your System 
 
Most users do not have access to the Pharmaserv Administration module because this is where your 
system administrator sets system preferences and assigns IDs and passwords for all authorized 
personnel. Customize your system by completing the following three steps: 
 
1. Set your System Preferences in System Administration. 
 
2. Establish your pharmacy profile in the Rx Processing application. 
 
3. Enter the city codes for your patients, prescribers, and businesses in the Rx Processing application. 
 
This section briefly explains how to complete the three steps above. 
 

Setting System Preferences 
 
System Preferences are established in System Administration on the server.  MPS recommends that 
the System Administrator establish this information before any data entry begins. Access the 
Pharmaserv Administration application by clicking on the Pharmaserv Administration icon (below): 
 

 
 
The default is ADMIN for both the Logon ID and Password. Click Admin on the menu bar and then 
click Preferences.  The Business tab displays on the Preferences window similar to the following: 

 

 
 
If the Business preferences are not displayed, click the Business tab. 
 
Review the Business preferences.  Use the Shift and F1 keys to access online Help regarding any of 
the fields. 
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Click the Counseling tab on the Preferences window to display the Counseling preferences:  
 

 
 
Review the Counseling preferences and make changes as needed.  Use the Shift and F1 keys to 
access online Help regarding any of the fields. 
 
Click the Medi-Span tab on the Preferences window to display the Medi-Span preferences:  
 

 
 

Review the Medi-Span preferences and make changes as needed.  Use the Shift and F1 keys to 
access online Help regarding any of the fields. The options selected determine what displays during 
various DUR screenings when filling prescriptions. 
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Click the Rx tab on the Preferences window to display the Rx preferences: 
 

 
 

Review the Rx preferences and make changes as needed.  Use the Shift and F1 keys to access online 
Help regarding any of the fields. The Rx Preferences control the default language and label format for 
prescriptions, whether cancelled (deleted) Rxs display in the history, maximum number of refills, age of 
Class 2-5 items, and other functions related to the entry and display of Rx information.  
 
Click the Table IDs tab from the Preferences window to display the last number used in your 
numbering sequence for your Rxs and counseling sessions:   
 

 
 

Review the numbering sequence and make changes as needed.  The example displays the last 
number used was 113, therefore the next available number is 114.  Use the Shift and F1 keys to 
access online Help if needed.  
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Click the Daily Rpts tab from the Preferences window to determine the characteristics of your daily 
reports:    
 

 
 

 
Review the Daily Reports preferences and make changes as needed.  Use the Shift and F1 keys to 
access online Help regarding any of the fields. 
 
Click the Pricing tab from the Preferences window to display the Pricing preferences: 
 

 
        
Review the Pricing preferences and make changes as needed.  Use the Shift and F1 keys to access 
online Help regarding any of the fields. The Pricing preferences enable you to select default acquisition 
adjustments, negative profit alert, price override, pricing interval for linked schedules and carrier 
brand/generic pricing options. 
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Click the Sign Off tab from the Preferences window to display the Sign Off preferences: 
 

 
 
Review the Sign Off preferences and make changes as needed.  Determine whether a pharmacist or 
technician has the authority to “sign off” or override the event (function) listed.  If the field is blank, no 
sign off is required. When Technician is selected, both pharmacist and technician can sign off.  Use the 
Shift and F1 keys to access online Help regarding any of the fields.   
 
When you have selected all of your preferences, click Save.  You are ready to establish other 
information to help you start using your pharmacy system.  From the File menu, click Exit to exit 
Pharmaserv Administration. 
 

Establishing Your Pharmacy Profile 
 
You must establish information about your pharmacy before you begin filling prescriptions.  This profile 
information is used throughout the system. 
 

1. Access the Rx Processing application. 
 

2. Select the Business module either from the Modify menu (click Business) or by selecting the 
Business horizontal tool bar button.  The Select Business window opens similar to the 
following: 
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3. Click OK if the Pharmacy name is listed; or click Pharmacy from the Type drop-down list box 
and click New.  The Pharmacy Maintenance window opens. 

 
4. Enter or select the appropriate information for each field.   

 
5. Remember, fields that are required display with a teal background. If you need information 

about the group field, press Shift and F1 to display the field-level Help for details. 
 

6. When all information is correct, click Save to save the business information. 
 

Establishing City Codes 
 
Many modules within the Rx Processing application require you to enter an address (for a patient, 
prescriber, carrier, etc.).  City Codes enable you to enter city, state, and Zip Code information by 
entering up to a five character code.  When filling Rxs, use this abbreviated code instead of typing all of 
the city related information each time. MPS recommends you establish your most frequently entered 
cities as city codes before entering your initial information.  
 
1. Access the Rx Processing application. 
 
2. Access Code Maintenance by clicking Code from the Modify drop-down menu. 
 
3. Click the City vertical tool bar button to access City Code Maintenance.  A window displays similar 

to the following:  
 

  
 

4. To add a city code, click Add and type up to five characters to use as a code for each city, state, 
and Zip Code you use frequently.  You can enter this code in place of the actual city, state, or Zip 
Code.  (NOTE: Many pharmacists prefer to use the last three digits of the Zip Code for the City 
Code.) 

 
5. Enter the city, state, and Zip Code to associate with the code.  (For details about any of these fields, 

place the focus on the field and press Shift and F1 to display the online Help for the field.) 
 
6. Click Save to save the City Code. 
 
7. Repeat steps 4-6 for each new City Code. 
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Verify Signa Codes and Caution Codes 
 
While you are in the Code Maintenance module, you should review the Signa Codes and Caution 
Codes that were entered before your system was delivered. 
 

1. To access the Signa Codes, click the Signa button. 
 

2. Review and make changes as needed. 
 

3. Save the changes or Cancel without making changes. 
 

4. Access Caution Codes by clicking the Cautions button. 
 

5. Review and make changes as needed. 
 

6. Save the changes or Cancel without making changes. 
 
 
You are ready to establish initial system information. 
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Establishing Initial System Information 
 
Once you have customized your system in Pharmaserv Administration, you can start to establish initial 
system information. Because the information entered in one module is often used by another module it 
is important that you establish information in a specific order.  Once you have established some initial 
information you can use the Rx Processing application to enter information as needed. This section 
covers establishing the following initial information (information must be established in the order listed): 
 
 • Pricing schedules (general pricing, copay, discount, premium, and special pricing) 
 
 • Tax table information 
 
 • Third party carriers (due to the sensitive nature of third party billing, MPS recommends that all 

third party carrier setup and maintenance information should be done with the help of an MPS 
representative.) 

 
 • Prescribers 
 
 • Businesses with which your pharmacy is connected 
 
 • Patients 
 

Establishing Pricing 
 
Pharmaserv enables you to accommodate many types of pricing schedules.  Pricing takes into 
consideration many factors such as markups and markdowns to multiple types of costs, unit dose 
pricing, generic/brand pricing, patient discounting, and more. 
 
Enter your basic pricing strategies as a specific general pricing schedule.  Rules for copays, discounts, 
premiums, and special pricing are entered separately.  Following is a brief explanation of the types of 
pricing schedules: 
 
Schedule Type Description 
Price (Default) Enables you to add price detail for use when pricing Rxs.  Default price 

schedules (cash pricing) are the starting point for all Rx pricing. This identifies 
cost basis, markups, fees, etc.  You must establish at least one price 
schedule for your default pricing. 

Copay A schedule for copayments based on patient age, Rx cost, Rx price, or days 
supply. 

Discount Enables the calculated price of each Rx to be adjusted by a specific amount, 
usually associated with a patient.  The basis of the discount may be Rx price, 
Rx cost, and/or patient age. 
MPS provides a default discount pricing schedule based on age as part of 
your base data supplied with your pharmacy system.  You can use this 
schedule or modify it as needed.  Only one age discount schedule is allowed. 

Special Price Pricing to designate retail prices for a specific quantity of a selected item 
(e.g., 30 of an item is $3.00, 60 of the item is $5.50, etc.). 

Premium An addition or subtraction to the calculated final price of an Rx based on the 
dispensed item’s form, category, class, and/or type. 
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MPS provided a Pre-Install Guide with worksheets for helping you determine your pricing 
strategies.  You can use these worksheets to help you enter the pricing schedules. 
 
If you provided MPS with printouts of your current pricing strategy, an MPS representative has 
already created your pricing schedules for you. 
 
All types of price schedules are established by using Schedule Maintenance.  To access the Schedule 
Maintenance window, click Modify to display the menu similar to the following: 
 

 
 
 Click Price Schedule Maintenance and a window displays similar to the following:  
 

 
 

 
Selecting the Type of Pricing Schedule to Add 
 
From Schedule Maintenance, select the type of price schedule you want to enter from the Schedule 
Type drop-down list box.  Enter a name for this schedule in the Name field and press Tab.  Click Yes to 
indicate you want to add a new schedule.  The appropriate pricing schedule window displays enabling 
you to enter the schedule. 
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Entering “Price” Schedule Type 
 
Select Price as the Schedule Type and a Price Schedule window displays similar to the following: 
 

 
 

NOTE: The Basis field in the Generic Pricing area (above) defaults to BRAND. This indicates the brand 
name item cost is used as the basis for calculating the generic selling price for generics using this 
schedule.  Select the GENERIC option from the Basis field to price a generic item from its own item 
cost. 
  
When you complete entries in this window, click Save. Then click Interval to enter the pricing intervals.  
Pricing intervals are the pricing minimum and maximum range, fee amount (dollar value), and the fee 
percent to be added to an Rx under this pricing schedule.  If both the fee amount and fee percentage 
are used, the price is calculated to add the dollar amount first and then add a percentage. 
 
Add as many interval levels that you need. Click Save to save the intervals. 
 
 
Entering “Copay” Schedule Type 
 
When Copay is the Schedule Type selected, the Copay Schedule window displays similar to the 
following:  
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Enter copay pricing information in this window.  Pricing intervals are the pricing minimum and maximum 
range, copay amount (dollar value or percentage) to be added to an Rx under this pricing schedule.  
Select the Basis of the copay from the drop-down menu. The copay amount is determined by your 
choice in the Basis field. Refer to online Help for field information, if necessary. 
 
After you have entered information click Save. 
 
 
Entering “Discount” Schedule Type 
 
When Discount is the Schedule Type selected, the Discount Schedule window displays similar to the 
following:  
 

 
 

Enter discount pricing information on this window.  Pricing intervals are the pricing minimum and 
maximum range, discount amount (dollar value), or the percent of discount to apply to an Rx under this 
pricing schedule.  If both the Amount and % are used, the price is calculated to subtract the dollar 
amount first and then subtract the percentage amount. Refer to online Help for field information if 
necessary. 
 
After you have entered information, click Save. 
 
NOTE:  To verify the discount applies to the appropriate schedules, check the Apply option (for that 

schedule) in the Patient Discount area on the Price Schedule window. 
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Entering “Premium” Schedule Type 
 
When Premium is the Schedule Type selected, the Premium Schedule window displays similar to the 
following:   
 

 
 

Enter the premium pricing information on this window.  Premium schedules are based on the attributes 
of an item defined in one or all of the four group boxes. Define a premium dollar amount or percentage 
amount to add to or subtract from the final calculated price.  The premium schedule can be attached to 
a specific price schedule. Refer to online Help for field information if necessary. 
 
After entering information, click Save. 
 
Entering “Special Price” Schedule Type 
 
When Special Price is the Schedule Type selected, the Special Pricing Schedule window displays 
similar to the following:   
 

 
 

Enter special pricing information on this window.  Special pricing enables you to define exact retail 
prices for specific quantities of a selected item. Refer to online Help for field information if necessary.  
Special Price schedules are attached to the item in the Pricing window in Item Maintenance. 
 
After entering information, click Save. 
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Entering Tax Information 
 
Because tax rates vary from state to state and for different item types, you may need to establish tax 
rates for items. 
 
1. Access Tax Maintenance from the Modify menu by clicking Tax.  A window opens similar to the 

following:  
 

  
 

2. To add tax information for an item, click Add. 
 
3. Enter the Item Type, Tax Basis, and Tax amount.  For details about these fields, place the focus on 

the field and press Shift and F1 to display the online Help. 
 
4. Repeat steps 2-3 for each item that needs a tax rate. 
 
5. When all tax rates have been entered, click Save.   
 
 

Entering and Importing Third Party Carrier Information 
 
Please consult an MPS representative regarding establishing, maintaining, and importing third 
party carriers. 
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Entering Prescribers 
 
Before filling and billing prescriptions, you should establish information about those prescribers with 
which you do business.  The Rx Processing application enables you to enter prescriber information 
while filling a prescription. However, you may want to establish some often-used prescribers in advance 
for faster processing. NOTE: If you are converting data from a competitor’s system, the information 
may already have been converted and added to the system. 
 
1. Access the Prescriber module from the Modify menu by clicking Prescriber or by clicking the 

Prescriber horizontal tool bar button.  The Select Prescriber window opens similar to the following:  
 

  
 

2. Enter the last name of the prescriber and click Retrieve to see if the prescriber already exists. If 
not, click New.  The Prescriber Maintenance and Prescriber Summary windows open similar to the 
following:  

 

 
 

3. Enter the information in the Prescriber Maintenance and Prescriber Summary windows.          
NOTE: The state license number is entered in the Prescriber Alternate ID Maintenance window. For 
details about fields on these windows, place the mouse pointer in the field and press Shift and F1 
to display the online Help. 
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4. To assign an alternate ID number to the prescriber, click Alt IDs.  The Prescriber Alternate ID 

Maintenance window opens. Select an ID Type and enter the associated ID number.  Refer to 
online Help for field information if necessary. 

 
5. Click Save to save the information. 
 
6. Repeat steps 2-5 for each prescriber. 
 

Entering Businesses 
 
Rx Processing enables you to enter and maintain information on the businesses with which you work, 
including your pharmacy.  Information on entering your initial pharmacy information was covered in 
Customizing Rx Processing.   
 
When you enter a profile for a business associated with your pharmacy, you must assign the business 
a type.  The type of business reflects the information you may enter about the business. 
 
Rx Processing enables you to enter the following business types in addition to your pharmacy: 
 
 • Employer 
 
 • Facility 
 

• HL7 Partner (NOTE:  You must be licensed to use the HL7 feature to enter this type.) 
 

 • Supplier 
 
 • Transfer Pharmacy 
 
All types of businesses are established in Select Business in the Business Module.  To access the 
Select Business window, click the Business horizontal tool bar button or, from the Modify menu click 
Business. The Select Business window opens similar to the following:   
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Entering The Type of Business 
 
From the Criteria area on the Select Business window, select the type of business you want to enter 
from the Type drop-down list box. 
 
Entering Employers 
 
To enter employer information (e.g., for Workers Compensation), select Employer from the Type drop-
down list box, then click New.  The Business Maintenance and Employer Maintenance windows open 
similar to the following:  
 

 
    
Enter information in the Business Maintenance and Employer Maintenance windows.  Click Save to 
save the information. 
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Entering Facilities 
 
To enter facility information (e.g., nursing homes, hospitals), select Facility from the Type drop-down list 
box, then click New.  The Business Maintenance and Facility Maintenance windows open similar to the 
following:  
 

 
 

Enter the information in the Business Maintenance and Facility Maintenance windows.  Click Save to 
save the information. 
 
Entering Suppliers 
 
To enter supplier information (e.g., wholesalers), select Supplier from the Type drop-down list box and 
click New. The Business Maintenance and Supplier Maintenance windows open similar to the following:  
 

 
 

Enter information in the Business Maintenance and Supplier Maintenance windows. For details about 
any of the fields on these windows, place the focus on the field and press Shift and F1 to display the 
online Help. 
 
Click Save to save the information. 
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Entering Transfer Pharmacies 
 
To enter information about pharmacies that you transfer Rxs with, select Transfer Phcy from the Type 
drop-down list.  Then click New.  The Business Maintenance and Transfer Pharmacy Maintenance 
windows open similar to the following:  
 

 
 

Enter information in the Business Maintenance window.  In Transfer Pharmacy Maintenance, the only 
required information is the DEA number and the name of the pharmacy. For details about these fields, 
place the focus on the field and press Shift and F1 to display the online Help. Click Save to save the 
information. 
 

Entering Patient Information 
 
You can enter new patient information at any time.  Before you begin using the Pharmaserv system, 
you might want to enter information about your current patients.  Or, you can wait and enter information 
when the patient comes in for a prescription.  NOTE: If you are converting data from another system, 
the information may already have been converted and added to the system. 
 
1. Access the Select Patient/Rx window from the Rx menu by clicking Patient/Rx or by clicking the 

Patient horizontal tool bar button. The Select Patient/Rx window opens similar to the following:  
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2. Search for the customer first by entering the patient’s last name and first name. Click Retrieve. 
 
3. If the customer does not exist in the patient file, click New Pat. The Patient Maintenance and 

Patient Summary windows display similar to the following:  
 

  
 

4. Enter other information in the fields in the Profile area and click Save. 
 
5. Assign the patient to a family or as the Head of Family, when prompted.  Instructions for assigning a 

patient to a family can be found in the online Help. 
 
6. Click OK to exit the Select Family window. 
 
7. Enter information in the remaining Patient Maintenance fields. 
 
8. Enter information in the Patient Summary areas. 
 
9. Click Save to save the information. 
 
 
Entering Additional Patient Information 
 
While not required, you may enter the following additional patient information: Allergies, Medical 
Conditions, Insurance Coverage, Vital Signs, Counseling Information, and Notes. 
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To enter patient allergies 
 
1. Enter allergies, by moving the focus to the Allergies view area. 

 
2. Click the Maint vertical tool bar button. 

 
3. Click Add. 

 
4. Enter information as needed. 

 
5. Repeat steps 3 and 4 to add other allergies. 
 
6. Click Save to return to the Patient Summary window. 
 
 
To enter patient medical conditions 
 
1. Move the focus to the Medical Conditions view area.  NOTE: For use in adjudication, the medical 

conditions must be assigned to an Rx via the Clinical Information window.  You can use the 
description NO KNOWN MED CONDITION when a specific condition is not listed in the Description 
field. 

 
2. Click the Maint vertical tool bar button. 
 
3. Click Add. 
 
4. Enter information as needed.  NOTE: You can select the NO KNOWN MED CONDITION option 

when a specific condition is not listed in the Description field. 
 
5. Repeat steps 3 and 4 for each medical condition to add. 
 
6. Click Save to return to the Patient Summary window. 
 
 
To enter patient insurance coverage information 
 
1. Move the focus to the Carrier Cvg view area. 
 
2. Click the Maint vertical tool bar button. 
 
3. Complete the information in the Patient area on the Patient Coverage Summary window and click 

Save. 
 
4. Click Add. The Select Carrier window displays. 
 
5. Enter a Carrier Code and click Retrieve. Select a code (if more than one displays) and click OK. 
 
6. Complete the information in the Patient Coverage Details window. 
 
7. Repeat steps 4 through 6 for each coverage. 
 
8. Click Save twice to save information and return to the Patient Summary window. 
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To enter patient vital signs 
 
1. Click the Vitals vertical tool bar button. 
 
2. Click Add and enter information as needed. 
 
3. Repeat step 2 for each new vital sign. 
 
4. Click Save to return to the Patient Summary window. 
 
 
To enter patient counseling information 
 
1. Select the Counsel vertical tool bar button. 
 
2. Click New. 
 
3. Enter the information as needed. 
 
4. Repeat steps 2 and 3 for each counseling session. 
 
5. Click Save to return to the Patient Summary window. 
 
 
To enter notes about the patient 
 
1. Click the Notes vertical tool bar button. NOTE: Be certain that the focus is not in the Allergies, 

Medical Conditions, or Carrier Cvg areas. 
 
2. Select the Note Type from the drop-down list box. 
 
3. Enter information in the Note Text area. 
 
4. To add more than one note, click New Note and then repeat steps 2 and 3. 
 
5. Click Save to return to the Patient Summary window. 
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Appendix A 
Base Data 
 
To enable you to begin using your Pharmaserv system, McKesson Pharmacy Systems has provided 
some base data already loaded on your system. This chapter identifies the base data that has been 
loaded. 
 
Item File 
 
An extensive item file has been loaded to your system. Customers converting from a competitor’s 
system have the Drug File converted if requested and, if you provided MPS with printouts of your 
pricing strategy, an MPS representative creates the pricing schedules for you.  
 
Pricing Schedules 
 
A default Price Schedule, based on AWP, is provided with your system.  No fees have been applied.  A 
default Discount Schedule, based on patient age, is also provided with your system.  You may use 
either pricing schedule or modify as needed. 
 
Cash Carrier 
 
A cash carrier has been established on your system.  You may set up defaults in Cash Carrier 
Maintenance. 
 
Frozen Codes 
 
Certain code groups have been defined by MPS and cannot be added to or changed.  Codes are 
“frozen” for various reasons: 
 
 • The codes are the same for all users and no other variations are valid 
 
 • The codes are defined by an outside source and must be the code used by that source 
 
 • Codes are common abbreviations that the Pharmaserv system uses 
 
Some examples of frozen codes are: 
 
 • The two character code for each state 
 
 • Allergy classification codes used by the Medi-Span database 
 
 • Codes of Y for Yes and N for No 
 
 • Business type codes that display the appropriate Business Maintenance window 
 
 • Maximum Allowable Cost source files 
 
Codes that are frozen do not display as an option in Code Maintenance. 
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Modifiable Codes 
 
For some modifiable code groups, MPS has defined some base codes for you.  Other code groups are 
unique to each pharmacy and no codes have been defined.   
 
Base Codes Assigned 
 
The following code groups have base codes already assigned: 
 
 • Caution Codes 
 
 • Item color 
 
 • Item flavor 
 
 • Language 
 
 • Maximum patient age 
 
 • Minimum patient age 
 
 • Potency Unit 
 
 • Price override reason 
 
 • Item Shape 
 
 • Signa Codes 
 
 • User Category 
 
 • Vital signs 
   
You may add additional codes to any of the categories in these code groups.  
 
User Defined Codes 
 
The following code groups have no codes assigned: 
 
 • Claim Status 
 
 • EPSDT (Early Planning Screening Diagnosis Treatment) 
 
 • Patient Types 
 
 • City Codes 
 
You can add additional codes to any of the categories in these code groups in Code Maintenance. 
 
 
Codes can be assigned to the following code groups while adding patient information: 
 
 • Medical Conditions text 
 
  • Allergies text 
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Appendix B 
Understand The Pharmadmin User 
 
The Pharmacy Store Manager (pharmadmin) ID/Role and the associated password is the “key” that 
opens the Pharmaserv system and enables you to determine user access to the system.  Your 
Pharmaserv system is shipped with a management account setup with a temporary password that can 
be provided to you by an MPS representative.  
 
Pharmadmin is a temporary store manager ID provided to enable you to create and assign other users 
including assigning the Store Manager role.  The first user created should be for the person that will be 
designated as Store Manager.  Once created pharmadmin should be logged out of and no longer used. 
 
 
Store Manager Role 
 
The Store Manager login provides a central point for managing your system users. You may want to 
limit the following information to one individual or a small group of individuals. A Store Manager is a 
person in your organization who is responsible for performing and monitoring key system functionality 
including: 
 

• Create user accounts 
• Manage users (disable, enable, and delete users, reset or unlock accounts, and designate a 

user as a store manager)  
• Install all Pharmaserv software and upgrades 
• Maintain Microsoft Windows updates 

 
Consult with your MPS Field Installation Consultant for more information. 
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Create User Accounts 
 
Before creating individual accounts, you should determine a naming convention to easily track 
accounts. A simple naming convention would be to use the first initial and the last name. For example, 
John Doe would become Jdoe. 
 
Complete the following steps to create a new user: 

1. Click the Tools icon on the desktop.  The Tools window displays similar to the following: 

 
2. Double-click the Pharmaserv System User Manager option.  The Pharmaserv System User 

Manager window displays similar to the following: 
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3. Click the Create user button.  A window displays similar to the following: 

 
4. Type the name of the user in the enter user name to create field.  You can enter up to 20 

characters.  You cannot use spaces and it is strongly recommended not to use special 
characters. 

NOTE:  To designate the user as store manager, check the Store Manager check box.  The 
Store Manager check box displays after you type one character in the Enter user name to 
create field similar to the following: 

 
A Store Manager is a user with privileges to manage (create, modify, delete, etc.) other users 
and to run Pharmaserv upgrades.  

5. Click Submit to save your entry.  A confirmation window displays with the initial password for 
the account.  The user is required the first time they log into the system to use this password to 
access the system and create their own personalized password.  Passwords must have a 
minimum of at least one upper case alpha character, one lower case alpha character, one 
numeric character, and one special character.  Passwords are valid for 90 days at which time 
you will be prompted to create a new password. 
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Managing Users 
 
You can disable, enable, and delete users, reset or unlock accounts, and designate a user as a store 
manager. 

Complete the following steps to manage existing users: 

1. Click the Tools icon on the desktop.  The Tools window displays. 

2. Double-click the Pharmaserv System User Manager option.  The Pharmaserv System User 
Manager window displays. 

3. Click the Manage existing user button.  The Select user to manage drop-down list displays. 

4. Select the name of the user for which you want to make changes.  Your window should look 
similar to the following: 

 
5. Perform one of the following actions: 

• To reset or unlock a user account, select the Reset/Unlock account button. 

NOTE:  If you reset a user account, a temporary password is provided for you to create a 
new password. 

• To disable a user, select the Disable user button. 

• To enable a user, select the Enable user button. 

• To delete a user, select the Delete user button. 

• To designate a user as store manager, select the Update user button and then check the 
Store Manager check box.  Only a Store Manager has permission to access the 
Pharmaserv System User Manager utility. 

6. Click Submit to save you entry.  

7. Click OK at the confirmation window. 
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Install All Pharmaserv System Software And Upgrades 
The Store Manager accounts are the only accounts that provide access to install Pharmaserv system 
upgrades. To be compliant with your contract with McKesson Pharmacy Systems, you must install all 
Pharmaserv software upgrades from McKesson Pharmacy Systems. 
 
NOTE:  MPS does not support non-MPS software and it should never be installed on your SERVER 

system. You should contact an MPS support representative to determine software compatibility 
issues if you are considering the use of non-MPS software on a client system. 

 
 
Maintain Microsoft Windows Updates 
If you are connected to the Internet, Microsoft periodically releases system security updates. A small 
yellow shield or globe icon may also display in the system tray. When updates are available from 
Microsoft, a message displays similar to the following: 
 

New updates are ready to install.  Click here for more information. 
 
Click OK (or double-click the icon) and follow the prompts to install the updates. 
 
NOTE: Some system security updates require a system restart at the server system.  When 

necessary, you are prompted to restart your system now or later. When you decide to restart 
your system, be certain that all users are logged off the Rx Processing and Pharmaserv 
applications and logged off from the Remote Desktop session. 

 
To verify you have the latest updates installed: 

1. Open Internet Explorer and click Tools. 
2. Click Windows Updates and follow the prompts on the Windows Update window. 

 
Service Pack Updates 
Please contact MPS before loading Service Pack Updates from Microsoft as these must be approved 
by MPS prior to installation. 
 
McAfee VirusScan 
McAfee VirusScan is the virus protection software approved for use with systems from MPS. The 
system is configured to automatically pull updates from the following URLs if connected to the Internet. 
If FTP fails, it tries HTTP. 

 
FTP: ftp://ftp.nai.com/commonupdater  or HTTP: http://download.nai.com/Products/CommonUpdater 
 
Rebooting (restarting) The Server 
MPS suggests rebooting your server for only the following reasons: 
 

• A Pharmaserv Upgrade instruction 
• After a Microsoft Windows Update 
• As requested by an MPS representative 

 
 
 
 

ftp://ftp.nai.com/commonupdater
http://download.nai.com/Products/CommonUpdater
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